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Overview 

 
Wolfe et al. (2019) introduces an open source, semi-automated, Python-based graphical user interface 
(GUI) called the Monte Carlo Slip Statistics Toolkit (MCSST) for estimating dip slip on individual or 
bulk fault datasets. Using this toolkit, profiles are defined across fault scarps in high-resolution digital 
elevation models (DEMs) and then relevant fault scarp components are interactively identified (e.g., 
footwall, hanging wall, and scarp). We reference hanging wall and footwall throughout because this 
code was developed for use in a rift setting; however, upthrown and downthrown are equally viable 
terms considering the underlying math should be consistent for reverse faults as well. 
 
Displacement statistics are calculated automatically using Monte Carlo simulation (Thompson et al., 
2002) and can be conveniently visualized in Geographic Information Systems (GIS) for spatial 
analysis. Fault slip rates can also be calculated when ages of footwall and hanging wall surfaces are 
known, allowing for temporal analysis. This method allows for rapid analysis of tens to hundreds of 
faults in rapid succession within GIS and a Python coding environment. Application of this method 
may contribute to a wide range of regional and local earthquake geology studies with adequate high-
resolution DEM coverage, both regional fault source characterization for seismic hazard and/or 
estimating geologic slip and strain rates, including creating long-term deformation maps. An ArcGIS 
version of these functions are available, as well ones that utilize free, open source Quantum GIS 
(QGIS) and Jupyter Notebook Python software. 
 
This manual provides step by step directions for implementing the workflow. Whether using a QGIS 
or ArcGIS interphase, instructions are provided on how to extract data from profiles drawn across 
fault scarps imaged in high resolution digital elevation data. Next, instructions on how to implement 
the MCSST to rapidly calculate slip statistics for the faults in question. Lastly, instructions are 
provided on how to visualize the results in the QGIS and ArcGIS interphases. 
 
All of these scripts and notebooks are available for download at the GitHub repository. The scripts 
were developed in Python 2.7.13 (to be compatible with ArcGIS). ArcGIS v 10.5.1 was used for 
testing but it might work in other 10 versions 
 
 
  



 

Profile Selection 
 
The first step is to define profiles across fault scarps imaged in digital elevation data. 
 

A) QGIS 
 

• Create a new Shapefile Layer 
o Layer -> Create Layer -> New Shapefile Layer 
o Geometry Type -> Line 
 

 
 

• The newly-created Shapefile layer show up in the Layers inventory. 
• To draw a profile and assign it to this layer, Toggle Editing on this layer. 

o Add Line Feature to draw your profile. Both Toggle Editing and Add Line Feature 
can be found in the banner of icons at the top of the program (see image below). 

o You may want to edit the Style of the lines so that they will have greater visibility. 
• Next, Save Layer Edits to permanently create your profile lines within the Shapefile layer. 

 



 

 
 

B) ArcGIS 
 

● Click on the Catalogue tab  
o Navigate to a folder where you would like to store your files 
o Right click and select New File Geodatabase 
o Right click on the newly created File Geodatabase and select New Feature Class  

▪ Give Name 
▪ Type: Line Features 
▪ Pick Coordinate System 

● Within the Table of Contents and Layers panel: 
o Right click on your new Line Feature Class 

▪ Select Edit features then start editing. Click continue on prompt of 
‘warnings’. 

▪ Display the Editor Tool Bar from Customize -> Toolbars -> Editor 
▪ Click the Create Features Icon 
▪ Click on your new Line Feature Class in menu to the right 
▪ In Construction Tools below, click Line 
▪ Draw line and double click to finish 
▪ When you are finished digitizing your new profiles, select Editor (drop down 

feature from Editor Toolbar), Save Edits, Stop Editing. 

Toggle Editing, Save 
Edits, Add Line Feature 

New Shapefile 
Layer 



 

 
 

● The Section Line Feature Class must have a “id” field. This is a field that may need to be 
added manually to the attribute table. To do this, open the attribute table, add field titled “id”, 
and then run an operator on the new “id” field to populate this field with the values of the 
“ObjectID” field. The operator tool is called the “Field Calculator” tool. You will see that 
when you open this tool, a blank dialogue box appears. You also see the beginning of a 
calculation right above. Fill in the rest of the calculation as “= ObjectID”. Next hit OK. You 
will only be able to undo your edits if you are in an edit session, so to be cautious, do this 
before you “stop editing”. 

  



 

Profile Data Extraction 
 
Once you have defined your profiles, the next step is to generate data along the profile. Plug-ins for 
ArcGIS and QGIS can be utilized for this process. 
 
If you do not have geologic data (e.g., age, formation name, etc.) you will need to quickly 
generate this data by following this workaround for ArcGIS and QGIS. 
 

A) ArcGIS 
 
The goal of this workflow is to create a new polygon feature class to contain user-generated 
geologic data so that the toolbox will function in the following step to extract data. 
 

• Create a new polygon feature class 
o Navigate to the ArcGIS Catalog 
o Right click on a geodatabase 
o Generate a new Polygon Feature Class 
o Include new fields for age and geology as is shown in image below 

 

 
 

o Right click on the new Feature class and choose Start Editing 
o Create a polygon feature that encompasses the entire study area. 

 

 
 

o Create a polygon feature that encompasses the entire study area. 



 

o Manually input data into the Attribute Table 
 

 
 

o Save Edits and Stop Editing 
 

 
B) QGIS 

 
o Create a new polygon Shapefile Layer 
o Add new fields for age and geology 

 

 
 

o Toggle Editing 
o Draw new Polygon Feature encompassing entire study site and input information 

for age and geology when prompted. 
o Toggle Editing to Save Edits 



 

 

 
 
Extracting Data 
 

C) QGIS 
 

Previously compiled GUIs can be employed to extract distance, elevation, and geologic age data 
along the fault profiles at variable spacing. The user will employ the Points Along Geometry and 
Point Sampling Tool plugins, which are within the QGIS environment. 

The Points Along Geometry Tool plugin creates points at regular intervals along line or polygon 
geometries. Created points have new attributes added for the distance along the geometry and the 
angle of the line at the point. An optional start and end offset can be specified, which controls 
how far from the start and end of the geometry the points should be created. This can be useful if 
you do not want to include the entire fault scarp profile; however, it is often simplest to start and 
end at the terminal points of the profile. 

If you do not see these tools, you can find them in the Manage and Install Plugins feature of 
QGIS. 



 

• Within the Toolbox, navigate to and open the Points Along Geometry Tool. 

 

• Set your density of points along the profile. Here I have set it to 1 meter. 
• Add a file path and new file name to create a new file for the points in the final dialogue 

box. 



 

 

• You can now see that the profile is composed of many points spaced at 1 meter. 

The Point Sampling Tool plugin collects polygon attributes and raster values from multiple layers 
at the specified sampling points created using the Points Along Geometry Tool plugin. The user 
needs a point layer (our newly created points) with locations of the sampling points and at least 
one polygon or raster layer from which to probe values (the elevation and geologic age data). The 
plugin creates a new point layer with locations given by the sampling points and attributes taken 
from the underlying polygon or/and raster cells, which represent the data that can be extracted 
from the high-resolution DEM and geologic map. 

• You may need to install the Point Sampling Tool from the Manage and Install Plugins 
function 

• Make active all layers you wish to extract data from (e.g., Geology and Elevation Data). 
• Designate name for output file and save it as a Shapefile. The default is Geopackage. 



 

 

 

• The above photo is the output of the process. You can see that at each point, geologic age 
and elevation data have been extracted. 
 

D) ArcGIS 

Point Sampling Tool 



 

The user has two options to complete this process with ArcGIS. The first is with an ArcToolbox 
and the second is with a Stand Alone Python script. Both of these were developed for this study. 
Please note: The scripts were developed in Python 2.7.13 (to be compatible with ArcGIS), 
ArcGIS v 10.5.1 was used for testing but it might work in other 10 versions, and the user will 
require the ArcGIS (for both) and Spatial Analyst (for createProfileCSV.py only) licenses to run 
these scripts 

ArcToolbox Approach 

• The ArcGIS_Toolbox folder contains the ArcGIS Toolbox together with the scripts that 
are called from it. The user will have to copy the whole folder to their machine (to 
maintain relative paths within the toolbox) and add the toolbox to their ArcMap project or 
ArcCatalog. The scripts could be run from there and ArcGIS has an interface for entering 
inputs (see below). 

• Within ArcGIS, the user must navigate to their ArcToolbox, right click, and select Add 
Toolbox. 

• Add the FaultProfile Toolbox to the working environment through this process. 
• Double click on the ‘createProfileCSV’ tool within this newly added toolbox. 

 

 



 

 

• Fill in the dialogue boxes as appropriate 
o The Working folder is the location to output your soon to be created profile data. It 

would make sense to make the output folder the working directory for your Jupyter 
Notebook environment so that you can easily navigate to the newly created profiles in 
the fault scarp analysis step. 

o The DEM is the elevation file from which you wish to extract the elevation data 
o The Geology layer is the shapefile layer that contains the age and unit name 

information 
o Select the age fields and unit name fields from the drop-down menus. These are 

headers within the Geology layer chosen. 
o The Profile layer is the shapefile layer created in the previous step that contains 

profiles drawn across fault scarps. 
o Select the unique id field for each profile of the Profile layer. 
o Select the point sampling density from which you would like to extract data along the 

profiles. 
• The resulting profile data will be stored in a new folder within the Working folder assigned in 

the previous step. Each profile will be saved as a separate CSV. The name of the folder will 
be “outputs_” + the name of your profile shapefile. 

Python Stand Alone Approach 

● The createProfileCSV.py code can be used in a python standalone environment to complete 
the same workflow. It requires the user to manually input the entries for the dialogue boxes of 
the ArcToolbox approach, including the full path to each file. The user will be prompted to 
fill these in once the script is launched. 

o The code will create a csv file for each section line and put each file into a folder 
called “Outputs_(name of your Line Feature Class)”. 

o The file for each profile will include a list of points at which the data was extracted. 
 



 

 
 
  



 

Fault Scarp Analysis GUI 
 

Next, each fault scarp profile can be analysed in preparation for net slip calculations.  

● An easy-to-use GUI is used to manually select the data to represent the Hanging wall, 
Footwall, and Scarp for each profile generated in the previous steps. 

● The program of choice for running this section of the code is Jupyter Notebook, which can be 
downloaded online free by downloading Anaconda 
https://www.anaconda.com/download/#windows 

● Launch the Jupyter notebook script. 
● You will need a few packages that might not come already installed. You can install these 

easily within your computer’s terminal. 
o If you are using a Mac, type the following (followed by an enter command) in your 

command terminal.  
pip install setuptools 
pip install msgpack 
pip install qgrid 
jupyter nbextension enable --py --sys-prefix qgrid 
jupyter nbextension enable --py --sys-prefix widgetsnbextensionpip install 
jupyterlab 
jupyter labextension install @jupyter-widgets/jupyterlab-manager 
jupyter labextension install qgrid 

● If you are using a Windows environment, download the packages through the Anaconda 
interphase by navigating to the Environments tab within the Anaconda Navigator. The 
extensions must then be enabled via the Anaconda Prompt terminal. 

jupyter nbextension enable --py --sys-prefix qgrid 
jupyter nbextension enable --py --sys-prefix widgetsnbextensionpip install 

 
 

● Next, load the jupyter notebook from the Anaconda Prompt terminal. 
● Now, you are ready to start analysing the fault scarp profiles. 
● With the Jupyter Notebook up and running, make sure that the working directory is set to the 

location of the folder that contains the csv file. You can check this by typing ‘ls ‘and entering 
the command. If it is not, you can navigate to that folder by typing ‘cd “subfolder in current 
location”’. Or by typing ‘cd ..’ to step back one folder level. 

● If you used the QGIS version of the data extraction process, then you will first need to 
separate your CSV file into separate files with one for each profile. The first step of the 
Python notebook will do this for you. 

o You will need to create a file structure similar to this one: 
▪ Folder Name: Profiles 
▪ Subfolder Name: Raw 
▪ SubSubFolder Name: Transect 1 
▪ The original CSV file with the data you exported from QGIS 
 



 

 
 

● After running this portion of the notebook, you should see individual profiles in the Raw 
folder. 

 

 
 

● If you used the ArcGIS version, your files should already be separated into their individual 
profiles. 

● It is likely that the headers of your CSV will not be the same as those used in the development 
test case. Thus, you will need to manually change the header names in this tab so that the 
notebook will read in the data correctly. 

 

 
 

● Running the next set of commands will launch the data manipulation widgets and display 
your first profile. 

 



 

 
 

● By running the following command box, you will launch an interactive data table. 
Manipulate and filter the data to fit the red line to the surface you believe represents the 
footwall. You can do this by clicking the filter button at the top of each column and then 
sliding the bar to only contain data within the range you would like to view. The red line 
should update in accordance with the subset of data that remains in the data frame.  

● Sometimes, the interactive table and subsequent line of best fit created from the subset of 
data selected can be buggy. Often times, it was necessary to chose a subset of data with 
the sliders and then re-load the graph above. Then it would allow the user to interactively 
update the polyline choice in real time. 

● This is only necessary on the first profile when launching the notebook to get the widget 
started. Then it should work cleanly throughout the analysis. 

 



 

 

 

● Once you have made your selection, run the box that saves the data within the FW 
variable. It is important to not run the HW and SC boxes until you have completed a 
similar process for each.  
 

 
 



 

● Next, re-filter the data within the interactive data frame so that the red line fits the 
hanging wall surface. You can remove you previous filtered selection by clicking the 
filter button on the row and then selecting reset. 
 

 
 

● Now run the HW box to save this data as the HW variable, just as was completed for 
the FW. 

● Do the same for the Scarp.  
 



 

 
 

● Run the SC box. 
● Next, the GUI will allow you to visualize your choices while displaying the original data. If 

you do not like your choices, you can do the previous process again and re-save new data as 
you see fit. 



 

 
 

● This is a simplified representation of the fault profile broken down into its three components 
(HW, FW, and SC) based on the selections you have chosen. If you like the selection, run the 
next box to save the file. The script will save the new filtered data as a separate file and also 
save a JPG image of this fault geometry to keep for your records. 

● The file will be saved within the same folder, but will have the title ‘processed’ in front. The 
script will create the processed folder for you if it does not already exist. 

● You should now have the following files: 
 

 

• Now you are ready to load in the next fault scarp profile and complete the process over 
again. 

  



 

Monte Carlo Slip Statistics Calculation 

 

Now that you have processed all of the fault profiles, the jupyter notebook can calculate all of the slip 
statistics at once in a batch process. Running this process multiple times will just rewrite the output 
files for each individual profile, so it does not matter whether you run this step last or throughout. 
There are plots created for each profile, as well as a summary table with the statistics for each. 

• The first box will allow you to set up a fault geometry distribution. 
• You can set the dip of the fault and the position of the fault’s intersection with the scarp 

 

 
• Running the next box will calculate the statistics for each fault profile. 

 

  



 

Outputs 

• The output of the code will include slip statistics and histograms of slip statistics for 
visualization. These will also be saved as individual files in a new folder the script creates 
called Outputs. 
 

 

 



 

 
 
 
  



 

Data Display in GIS 
 

a) QGIS 
 

 
 

• To display in QGIS and associate these statistics with the original profiles, we will use the 
Join Fields tool. 

• Load your CSV where the final part of the file name is “_join” into QGIS. 
• Open the Properties of the original Shapefile and navigate to the Joins tab. 
• Click the “+” sign to add a new Join. 
• Select your csv file with the extension “_join” as the Join Layer. 
• Select the ID fields of the Join Layer and the Shapefile layer as the Join Field and Target 

Field.  
• Hit OK and then Apply. 



 

 
 

• Now open your Attribute Table and the datasets should be joined. 
 

 
 

b) ArcGIS 
 

A toolbox was created to make attaching statistics to the original profiles seamless. 

• Launch the tool titled, “attachStats2Profiles” 
• Enter the required dialogue boxes including the full file path for the Stats CSV file 

 



 

 
 

• The statistics from the CSV file should now be attached to the profiles originally digitized in 
ArcGIS 

• Alternatively, the Python standalone script can be used. This will require manual entry to the 
full data file paths. 

 

 


